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Rulers as a measuring tool 

The most obvious role for rulers is as a measuring tool. As you move the mouse 
pointer, small lines along each ruler display the current horizontal and vertical 
cursor position. When you click to select an object, blue ruler regions indicate 
the object's left, right, top, and bottom edges. Each region has a zero point 
relative to the object's upper left corner, so you can see the object's dimensions 
at a glance. 

 

Using the dot grid 

 

The dot grid is a matrix of dots or lines based on ruler units, 
covering the page and pasteboard areas. Like ruler guides, it's 
handy for both visual alignment and snapping. 

To turn the dot grid on and off: 

• Enable (or disable) the Dot Grid button on the View menu. 

You can also set the grid spacing, style, and color via the Options dialog.  

Setting site properties 
Site properties allow settings to be made which will be applied across the entire 
site. Default page settings, HTML output control, search engine optimization, 
author/copyright, and web usage statistical information can all be set via the 
multi-tab Site Properties dialog. Generally speaking, decide on your Site 
property settings when you are planning your site—once set, the settings do not 
normally need to be modified (although you can at any time).  
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Setting page size and alignment 

Default site property settings for Width and Height determine the dimensions of 
any new page or master page. A default site property setting for alignment 
(either Left or Centered) determines how page content lines up in a browser. 

One of the first things you may want to do, when creating a new site from 
scratch, is to check the default dimensions and adjust them if necessary. You can 
adjust the dimension settings at any time—but as a rule, make changes before 
you've gone too far with laying out page elements! 

In general, use a page Width setting that will fit on a standard monitor (750 
pixels is usually safe) and won't force users to scroll horizontally. 

For page dimension and alignment, you can override the site setting for a 
particular page, as described in Setting page properties on p. 57. 

To set the site-wide page dimension settings: 

• On the dialog's Options tab, select different Width and/or Height 
values to apply to master pages. 

You can also change the default page alignment setting as a site property, or 
override it for a given page. 

To set the site-wide page alignment setting: 

• On the dialog's Options tab, select either "Left" or "Centered" in the 
Default page alignment drop-down menu. 

For more details on other tab settings, see online Help. 

Setting page properties 
Your WebPlus site has its own general framework, consisting of the site itself; 
one or more master pages; and a number of individual pages. Each aspect of 
the framework has various property settings that contribute to the look and 
behavior or your site when it's published. Whether you start with a WebPlus 
template or from scratch, you can choose whether to stick with the default 
property settings or alter them to suit your needs. 

Page properties of individual pages can be viewed either via the Site tab, by 
right-clicking on the active page in your workspace, or via the Site Manager. 
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The Site Manager offers a more powerful method of not just viewing but 
modifying the properties of multiple pages at the same time—simply check your 
chosen pages and alter one or more page properties. All checked pages will 
adopt the new settings. 

To view master page property settings: 

• Click the  Master Page Manager button above the Master Pages 
window on the Site tab. The Master Page Manager appears. 

To view normal web page property settings: 

• Right-click the page in the workspace and choose Page Properties.... 

The Page Properties dialog appears. 
 
Tab name Property 

Navigation 
(default) 

Page, title, and file name 
Each page has a "visible" page name or file name shown in 
Site tab's Site Structure tree. You can edit either, as well as 
choose a title different from the page name.  

 Include in navigation 
By default, all pages are included in navigation bars. Use this 
option to exclude the page from navigation. 

 Separators and Description 
If included in navigation, check Before and/or After to apply 
horizontal separator lines above/below the page as a submenu 
item in navigation bars. A Description box adds extra page-
related text information under the bar's submenu item.  

 Redirect 
After a configurable time interval a web page is redirected to a 
new hyperlink destination (another page, image, email, etc.). 

Appearance Page alignment 
Alignment determines how the page content appears in a 
browser. Use the Site's default page alignment setting (Use Site 
setting), or choose Left or Centered as an override. 
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 Width and Height 
Each master page always determines the size of pages that use 
it. For individual pages that don't use a master page you can set 
custom page dimensions. For pages using a master page, only 
the Height can be changed for the page. In the Master Page 
Manager (Properties button), you can override the site setting 
for a given master page. 

Background Master pages 
Assign one or more master pages to a specific page, or set a 
page to use no master page. 

 Use Color Scheme Designer Settings 
Adopts the site's current color scheme settings for background 
colors or uses a custom On-Page color and/or Background 
color/image. 

Effects Page Entry/Exit Transitions 
Page entry and exit transitions can be applied as you navigate 
from one web page to another. 

 Use Sound file 
Choose a background sound to load and play automatically 
when a specific page is first displayed.  

Page Security 

 

Page Security 
Apply access control to your web page(s) by assigning the 
page to a user group (via Serif Web Resources User List Smart 
object). 

Search Search engine descriptors 
Include optional descriptive information and keywords on 
individual pages, which override the site's search engine 
settings. 

Search Engine Sitemaps and robots  
Informs search engines or robots if they can crawl, analyze and 
index the current page. A Sitemap file will include the current 
page in indexing whereas a Robots meta tag (or a robots.txt 
file) will exclude the page. These settings override the site's 
search engine settings. 
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Using Site Manager 
WebPlus's Site Manager hosts a whole range of useful site-wide information 
available from a single menu-driven dialog. The tool lets you view Page/Master 
Page Properties, and pick from a selection of Management tools for viewing and 
editing hyperlinks (see below), resources, text, fonts, and much more. 

 

Powerful features of Site Manager include:  

• The ability to control the scope and to manage an individual, a 
selection or all pages in your site equally. 

• Any column can be sorted up or down which offers a quick way of 
reordering information. 

• Find and Replace. Where available, this is a powerful way of applying 
text changes across all web pages simultaneously. 

While most management tools are beneficial at any point in site development, 
the management of resources and text, as well as use of the Site Checker, are 
essential for checking your site just prior to web publishing. 

To launch Site Manager: 

• Click  Site Manager on the Hintline at the bottom of your 
workspace (or on the Pages context toolbar). 
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A quick summary gives an indication of what each management feature can do 
for you.  
 

Type of 
Management 

Lets you... 

Page/Master 
Page Properties 

Include pages in navigation (with separator control), 
assign master pages, set page alignment and size, 
rename pages, set a background, add sounds, optimize 
pages for search engines, and apply redirections, 
transitions, or access control. 

Hyperlink View and edit hyperlinks, jump to hyperlinks on the 
page, find and replace destination links.  

Anchor View and edit anchor name and location, include pages 
in navigation (with separator control), jump to anchors. 

Navigation Display the navigation bars used throughout your site. 

Resource View images, media, links, HTML code resources, 
scripts, or applets in your site. Jump to each resource on 
the page, swap between linked/embedded image status, 
replace or resample images. 

E-Commerce View E-Commerce objects on pages across your site. 

Text View and edit text (in WritePlus), name stories, 
reformat text, apply styles, convert creative frames and 
tables to HTML-compatible text. 

Font View fonts and their availability, jump to fonts on the 
page, and substitute fonts. 

File Display the site structure with page file names rather 
than page names. Add files to your site. Rename and 
move file locations. 

Site checker Display common layout problems discovered in your 
site. 
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Search engine optimization 
Indexing involves the automatic collection of information about your web pages 
by search engines such as Google, Yahoo!, Live Search, and many more. By 
"harvesting" this information at the search engine, search engine users can make 
use of this indexed information to obtain quick and accurate site search results 
which match the search criteria entered by the user. 

By default, the contents of each published web page (especially heading text) 
will be indexed. However, in an Internet world of billions of web pages all being 
constantly indexed, web developers can optimize this indexing process to allow 
a site's pages to appear higher in a user's search results. 

Optimization of web pages for search engines is possible in several ways: 

• Meta Tags: Tags store search engine descriptors (i.e., keywords and 
a description) for the site and/or an individual page. These tags are 
used to allow better matching between entered search engine text (like 
you might enter into Google) and the keywords you've associated with 
your site or page. Additionally, a robots meta tag also lets you 
include/exclude the site or pages from being indexed; hyperlinks to 
other pages can also be prevented from being explored (crawled by 
"spiders)". 

• Robots: Pages (or folders) can be excluded from search-engine 
indexing by using a robots file. This works in an equivalent way to the 
robots meta tag but uses a text file (robots.txt) to instruct robots or 
spiders what not to index. The file simply lists excluded site 
page/folder references. 

• Sitemaps: The opposite of the "robots" concept; pages can be 
included to aid and optimize intelligent crawling/indexing. site page 
references are stored in a dedicated sitemap file (sitemap.xml). 

 



Developing Sites and Pages  63 

 

Whether you are using Meta tags, robots, or sitemaps independently or in 
combination, WebPlus makes configuration simple. As these settings can be 
established or modified for the whole site (Site Properties; Search Engine tab) 
any newly created page will adopt site's search engine settings. If you change the 
site settings, all web pages will update to the new settings automatically. 
However, you can override the site's settings on a specific web page (Page 
Properties; Search Engine tab) at any time. The page's override means that 
subsequent changes to site settings will always be ignored. 

Using search engine descriptor Meta Tags 

Although they're optional, if you want to increase the likelihood that your 
website will be "noticed" by major web search services, you should enter Meta 
Tag search engine descriptors. Search services maintain catalogues of web 
pages, often compiled through the use of "crawlers" or other programs that 
prowl the web collecting data on sites and their content. By including descriptive 
information and keywords, you'll assist these engines in properly categorizing 
your site. You can enter descriptors for the site as a whole and/or for individual 
pages. For example, for a simple ornithological site you could have the 
following descriptors, reflecting the content of your site or page, e.g. 
 

 
Site Properties Page Properties 

Description American Birds Web Egret and Heron species page 

Keywords Birds, America, 
Audubon 

Cattle Egret, Blue Heron, Green-
backed Heron 

It's a good idea to plan which descriptors are used for the site and pages. If set, a 
site's descriptors will complement page-specific descriptors. 

To enter search engine descriptors: 

1. (For the site) Choose Site Properties... from the File menu. 
OR 
(For a page) Right-click the page in the workspace or Site tab and 
choose Page Properties... (or choose the item from the Edit menu). 

2. Click the dialog's Search tab. 
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3. In the top window, type in a brief description of your site. Although 
the description can be any length, the first ten words or so are the 
most important. 

4. In the next window, enter any number of keywords (separated by 
commas) that you think fairly categorize your site. Put yourself in the 
place of a potential visitor. What keywords might they enter if they 
were searching for exactly what your site or page has to offer? 

5. Set a language code for your site from the drop-down menu to identify 
your site's language use. Most user's Internet search engines will 
permit language specific searches for web pages, so your site will 
show in search results according to its language code setting. 

Excluding pages from indexing (robots meta tags) 

A robots meta tag can be used by search engine robots to control how they 
access the site or page. The whole site (and pages) can be set to be indexed/not 
indexed, page hyperlinks followed/not followed, or any combination thereof. 
Site-wide settings are made by checking Index pages on this site and Follow 
links from pages or as overrides on specific page properties. 

To enable robot Meta Tag generation: 

1. (For the site) Choose Site Properties... from the File menu. 
OR 
(For a page) Right-click the page in the workspace or Site tab and 
choose Page Properties... (or choose the item from the Edit menu). 

2. Select the Search Engine tab and check the Create robots meta tags 
option (for a page you'll need to override site-wide settings). 

3. (For the site) Use the two suboptions to allow or prevent search 
engines indexing the entire site (check/uncheck Index pages on this 
site option) or to allow or prevent indexing of all pages linked from an 
indexed page (check/uncheck Follow links from pages option). 
OR 
(For the page) Check Override site search engine settings and 
Create robots meta tag, then check/uncheck the equivalent 
suboptions for the specific page.  
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Excluding pages from indexing (Robots file) 

The objective of this method is the same as that for using a robots meta tag, but 
instead a robots.txt file is created and no robots meta tag is included in web 
pages. The robots.txt file is stored in the web site's root folder and can be viewed 
in any text editor to verify the excluded pages and folders. 

To enable a robots.txt file: 

1. Choose Site Properties... from the File menu. 

2. From the Search Engine tab, check the Create search engine robots 
file option. 

3. (For the site) To allow or prevent search engines indexing the entire 
site (check/uncheck Index pages on this site option). 
OR 
(For a page) From page properties, to prevent search engines indexing 
the page, check Override site search engine settings, then uncheck 
the Index this page option. 

Including pages in indexing 

So far we've looked primarily at methods of excluding web pages from 
indexing. Without these controls, web pages will be indexed by discovering 
page hyperlinks and crawling through them, harvesting keywords, descriptions, 
and page text to be indexed. However, this process may not be efficient as there 
may be a limited number of inter-page hyperlinks present throughout your site. 
As a result, a search engine sitemap file (sitemap.xml) can be created to act as a 
local lookup for crawlers to begin investigating your site. The file simply lists 
pages in your site that you've decided can be indexed. The file also indicates to 
search engines when pages have been modified, informs when the search engine 
should check the page and how "important" pages are in relation to each other. 

The Sitemap method is especially good for "advertising" your site pages—with a 
greater likelihood of your pages appearing high in a user's search results. 

Just like the robots file, the setting of site and page properties creates the sitemap 
file (this is published with your site); the file is stored in the root web folder 
(perhaps alongside a robots.txt file). 
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 One requirement of using search engine sitemaps is the need to 
declare an absolute URL. This allows the proper URL address (e.g., 
www.gizoo.com) to be indexed, allowing search engine users to 
link through to your site from their search results. 

To enable search engine sitemaps: 

1. Choose Site Properties... from the File menu. 

2. Check the Create search engine sitemap file option. 

3. (Optional) When the above option is checked, the default sitemap.xml 
file can be renamed. Click the Change... button and edit accordingly. 

4. (For the site) To populate the sitemap file with a list of all the site's 
web pages (for improved page "discovery"), the Index pages on this 
site option is checked. Uncheck to create an empty sitemap.xml file. 
OR 
(For a page) From page properties, to add the page to the sitemap file, 
check Override site search engine settings, then check the Index 
this page option. This assumes the site as a whole has not been listed 
in the sitemap.xml file. 

5. Check/uncheck Sitemap settings including: 

• Page's last modified date and time. 

• Page change frequency (set drop-down menu to hourly, daily, 
weekly, monthly, yearly, or never): This suggests to the search 
engine how frequently the page is likely to change. The search 
engine will decide how often to index the page on the basis of 
this setting. 

• Page priority rating: 0.0 (lowest) to 1.0 (highest). Sets a page 
priority relative to your other web pages by which search engines 
are most likely to index. The default can be set on site properties 
with specific page overrides setting a priority higher or lower 
than the default. 
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Prioritizing text with Heading HTML tags 

It is possible to assign paragraphs (or text styles) in your HTML frame or 
HTML table with a preferred HTML tags (H1, H2 ... to H6) for export. The tags 
can be assigned from Paragraph... on the Text menu (choose the 
Paragraph>HTML option); simply pick a preferred HTML tag for your 
paragraph from the drop-down menu. An advantage of this is that paragraphs 
assigned such tags take priority over other "body" tags (e.g., those using the <P> 
tag) when appearing in search engine results (the H1 tag is the highest priority). 

Using the Gallery 
The Gallery tab serves as a container for storing your own design objects you'd 
like to reuse in the same or different websites. Once you've copied a design to 
the Gallery, it becomes available to any site—simply open the Gallery! 

Additionally, the tab includes categorized pre-designed elements that you can 
customize and use as a starting point for your own designs. 

The Gallery has two parts: an upper Categories drop-down menu and a lower 
Designs window showing a list of thumbnails representing the designs in the 
selected category. You can adopt a design by dragging the thumbnail onto the 
page. 

 

The Gallery tab can store your own designs in the ready-to-go My Designs 
category—the design is made available in any WebPlus site. When you first 
install WebPlus, the My Designs gallery will be empty, ready for custom 
designs to be added to it. New categories can be created at any time. 

To further arrange your designs into logical groupings, you can add sub-
categories to My Designs or to any other custom or pre-defined category. 
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(Tab only) For calligraphic lines of variable width (drawn 
as if with a square-tipped pen held at a certain angle), 
select the calligraphic line style (opposite) from the drop-
down menu, then use the Calligraphic Angle box to set 
the angle of the pen tip, as depicted in the examples 
below. 
 

 

You can also vary a line's Cap (end) and the Join (corner) where two lines 
intersect.  

Drawing and editing shapes 
QuickShapes are pre-designed objects of widely varying shapes that you can 
instantly add to your page. 

 

Once you've drawn a QuickShape, you can morph its original shape using 
control handles, and adjust its properties—for example, by applying gradient or 
bitmap fills (including your own bitmap pictures!) or apply transparency effects. 

Another way to create a shape is to draw a line (or series of line segments) and 
then connect its start and end nodes, creating a closed shape. 
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QuickShapes 

 

The QuickShape flyout contains a wide variety 
of commonly used shapes, including boxes, 
ovals, arrows, polygons and stars. 

You can easily turn shapes into web buttons by 
adding hyperlinks or overlaying hotspots. The 
"QuickButton" (indicated) is especially 
intended for creating stylish button outlines! 

It’s also possible to use the always-at-hand QuickShape context toolbar situated 
above the workspace to adjust a QuickShape’s line weight, color, style, and more. 
New shapes always take the default line and fill (initially a black line with no fill). 

To create a QuickShape: 

1. Click the  QuickShape flyout on the Standard Objects toolbar 
and select a shape. The button takes on the icon of the shape you 
selected. 

2. Click on the page to create a new shape at a default size. 
OR 
Drag across the page to size your shape. When the shape is the right 
size, release the mouse button. 

To draw a constrained shape (such as a circle): 

• Hold down the Shift key as you drag. 

All QuickShapes can be positioned, resized, rotated, and filled. What's more, 
you can morph them using adjustable sliding handles around the QuickShape. 
Each shape changes in a logical way to allow its exact appearance to be altered. 

To adjust the appearance of a QuickShape: 

1. Click on the QuickShape to reveal one or more sliding handles around 
the shape. These are distinct from the "inner" selection handles. 
Different QuickShapes have different handles which have separate 
functions. 

2. To change the appearance of a QuickShape, drag its handles. 

 To find out what each handle does for a particular shape, move the 
Pointer Tool over the handle and read the Hintline. 
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Closed shapes 

As soon as you draw or select a line, you'll see the line's nodes appear. Nodes 
show the end points of each segment in the line. Freehand curves typically have 
many nodes; straight or curved line segments have only two (1). You can make 
a shape by drawing a line between node end points (2), or by simply closing the 
curve (3). 

 

To turn a selected line into a shape: 

• Select the line with the Pointer Tool and click the  Close Curve 
button on the Curve context toolbar. 

You can go the other way, too—break open a shape in order to add one or more 
line segments. 

To break open a line or shape: 

1. With the Pointer Tool, select the node where you want to break the 
shape. 

2. Click the  Break Curve button on the Curve context toolbar. A 
line will separate into two lines. A shape will become a line, with the 
selected node split into two nodes, one at each end of the new line. 

3. You can now use the Pointer Tool to reshape the line as needed. 

See online Help for information on editing shapes. 
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Using 2D filter effects 
WebPlus provides a variety of filter effects that you can use to transform any 
object. "3D" filter effects let you create the impression of a textured surface and 
are covered elsewhere (see p. 154). Here we'll look at 2D filter effects 
exclusively. The following examples show each 2D filter effect when applied to 
the letter "A."  

    

Drop Shadow Inner Shadow  Outer Glow Inner Glow  

    

Inner Bevel Outer Bevel Emboss Pillow Emboss  

    

Gaussian 
Blur 

Zoom Blur  Radial Blur Motion Blur 

    

Color Fill Feather Outline Reflection 
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Adding hyperlinks and anchors 
Hyperlinking an object such as a box, some text, or a picture means that a 
visitor to your website can click on the object to trigger an event. The event is 
most commonly a jump to one of the following: 

• site page  

• Internet page (somewhere on the web)  

• Email composition window 

• File on your local disk or network 

• Anchor (a designated target within a web page)  

• Smart object (specifically a forum or blog in Serif Web Resources)  

• RSS feed or podcast 

• Shopping cart 

• Navigation bar 

• User Data 

• Picture 

Well-designed hyperlinks are an important aspect of site structure. They help 
visitors navigate through your site and serve as an important adjunct to logical 
page relationships as shown in the Site Structure tree. (But don't overlook the 
time-saving advantages of using navigation bars.) 

  You can manage all hyperlinks and anchors throughout 
your site by using the Site Manager, accessible from the 
Default context toolbar or Hintline. 
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To add a hyperlink: 

1. Use the Pointer Tool to select the single or grouped object or 
highlight the region of text to be hyperlinked. 

2. Click the  Hyperlink button on the Tools toolbar. 
The Hyperlinks dialog appears. 

3. Click to select the link destination type, and enter the specific 
hyperlink target, i.e. a site page, internet page, Smart object, email 
address, etc. 

4. Depending on the link type, choose type-specific options 

5. A range of target windows or frames can be chosen depending on how 
you want the link destination to be displayed. The types (along with 
expected results) are: 

• Same Window: the link destination is shown in the same 
window from which the hyperlink was clicked. 

• New Window: A new window is used to display the link 
destination whose properties (dimensions, position, or navigation 
bar usage) can be defined via the Settings... button. The original 
window will remain open. 

• Top of Current Window: the link destination is shown in the 
top level window. 

• Named Window: A custom window can be defined by entering a 
new window name in the right-most drop-down menu. Its 
properties (dimensions, position, and appearance) can be defined 
via the Settings... button (check Use JavaScript popup code 
first). You can also adopt an existing named window from the 
same drop-down menu. 

6. Choose other properties such as Title name (text displayed on-screen 
on hover over) and a shortcut access key.  
Note: As a visual cue, hyperlinked words are normally underlined and 
appear in the color you've specified for Hyperlinks in the Color 
Scheme Designer or elsewhere (see Using color schemes on p. 211). 

7. Click OK. 
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To modify or remove a hyperlink: 

1. Use the Pointer Tool to select the object, or click for an insertion 
point inside the linked text. (It's not necessary to drag over a 
hyperlinked region of text.) 

2. Click the  Hyperlink button on the Tools toolbar's Hyperlink 
flyout. 

The Hyperlinks dialog appears with the current link target shown. If the link is 
in text, the whole text link highlights. 

• To modify the hyperlink, select a new link destination type, target, 
and/or options. 

• To remove the hyperlink, click No Hyperlink. 

To view or edit existing hyperlinks:  

• Choose Site Manager>Hyperlink Manager... on the Tools menu to 
view, rename, or remove hyperlinks. 

Inserting an anchor 

An anchor is a specific location on a page that can serve as the target for a 
hyperlink. Invisible to the web page visitor, it typically marks a point within 
some text (such as the start of a particular section) or an image at some point 
down the page. Anchors are useful if your page has enough content to be 
divided into sections, but not enough to require carving up into separate pages. 
These let the reader jump to related content without leaving the current page. In 
the same way, keeping web visitors on the same page makes it less likely they'll 
get "lost' while perusing the information on your site. 

To insert an anchor: 

1. Use the Pointer Tool to select the target object, or click for an 
insertion point inside the target text. 

2. Click the  Anchor button on the Tools toolbar's Hyperlink flyout. 
OR 
Choose Anchor... from the Insert or right-click menu. 
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3. In the dialog, type a name for the anchor. 

4. (Optional) Check Include Anchor in Navigation to allow the anchor 
(typically a selected object) to be accessed via a navigation bar instead 
of a hyperlink. You'll need to check Include anchors on your 
navigation bar first. Give the anchor a title. 

• Check Before and/or After to apply horizontal separator lines 
above/below the anchor as a submenu item in navigation bars. 

• Add a Description to add extra page-related text information on 
the bar's submenu item.  

5. Click Remove to delete the anchor intelligently, i.e., you can control 
what happens to any referencing hyperlinks (i.e., ignore, delete, or 
redirect). 

6. Click OK. 

 Anchors are page-specific, so it's OK to use the same anchor name 
on more than one page. WebPlus will create anchor names 
automatically in series for each page, and using prefixes for each 
type of object. However, you may find it easier to keep track of 
anchors throughout the site if you supply your own unique names—
it's up to you. 

To view or edit existing anchors:  

• Choose Site Manager>Anchor Manager... on the Tools menu to 
view, rename, or remove an anchor attached to a particular object. 
You can also include the anchor in page navigation. 

Adding hotspots to a page 
A hotspot is a transparent hyperlink region on a web page. Usually placed on top 
of graphics, hotspots act like "buttons" that respond when clicked in a web 
browser. They are especially useful if you want the visitor to be able to click on 
different parts of a picture (such as a graphic "menu" or map of your site). You 
can draw and edit hotspots by hand, or create them to match an existing shape. 
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To draw a hotspot: 

1. Click the  Insert Hotspot button on the Web Objects toolbar. 

2. Click and drag to draw a rectangular hotspot region. The Hyperlinks 
dialog appears. 

3. Click to select the link destination type, and enter the specific 
hyperlink target (see Selecting a hyperlink target on p. 223). 

4. Click OK. 

To match a hotspot to an existing shape: 

1. Draw the hotspot as described above, and create the shape as 
described in Drawing and editing shapes on p. 148. 

2. Select both objects and choose Fit Hotspot to Shape from the Tools 
menu. 

 The two objects will still be separate, so you can easily delete the 
shape if it's no longer needed once you've used it as a template to 
produce a hotspot of a desired shape. 

To modify a hotspot hyperlink: 

• Using the Pointer Tool, double-click the hotspot. 

The Hyperlinks dialog appears with the current hotspot link target shown. 

• To modify the hyperlink, select a new link destination type and/or 
target. 

• To remove the hyperlink, change the link destination to No 
Hyperlink. 
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Instead of a direct button, a hyperlink (see p. 223) can be created from anywhere 
in your site which links directly to your new feed. A special link destination type 
called RSS Feed is used. 

Subscribing via iTunes 

Once a broadcaster has submitted their feed to iTunes and had it approved, the 
web visitor can subscribe to the podcast as follows: 

1. Launch iTunes. 

2. Click Subscribe to Podcast... from the Advanced menu. 

3. Enter the feed URL in the dialog's input box, then click OK. The 
podcast appears as an entry in the window. 

 

New episodes can be downloaded via GET 
or GET ALL buttons next to each episode or 
feed, respectively (you can also right-click 
on a feed and choose Update Podcast. Media 
files will then be downloaded and will be 
available for playback directly within 
iTunes. 

To unsubscribe to the feed, use the 
Unsubscribe button at the bottom of the 
window. 

Including third-party feeds 

Instead of creating your own RSS feed or podcast you may wish to include an 
RSS feed from another website on your own web page—a web page's content 
can be boosted by inclusion of a feed from any popular news service (Reuters, 
BBC News, sport, etc.) or other information service (e.g., financial). Many 
major news and information services host lists of RSS feeds relating to specific 
areas of interest (geographical, entertainment, political, music, etc.) so it's just a 
case of copying the link for the website's RSS feed and pasting it into a dialog 
shown when clicking the WebPlus's RSS Reader Tool. Please bear in mind any 
terms and conditions in using a third-party RSS feed—these should be clearly 
indicated on the originating website. 
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The addition of the RSS feed reader to your page automatically subscribes 
yourself to the chosen RSS feed or podcast. There are other ways of subscribing 
to RSS feeds or podcasts via web browsers and iTunes, but here we'll focus on 
how to include the feed on your page and have it automatically receive articles 
or episodes. 

Here's an example of a financial RSS feed added to a WebPlus web page: 

 

To include an RSS feed or podcast on your page:  

1. Locate an RSS feed available on web pages of popular news and 
information services. Look for one of the following distinctive 
buttons, e.g.  
 

   

2. Copy and paste the Feed URL from a web page to the clipboard. For 
Internet Explorer, you can right-click on a subscribe button/link and 
choose Copy Shortcut. For Mozilla Firefox, choose Copy Link 
Location via right-click. 

3. Click the  RSS Reader Tool button on the Web Objects toolbar's 
RSS flyout. 

4. In the dialog, paste the Feed URL into the RSS Feed URL field. 
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5. (Optional) Select a different color, font, font size, or font style for the 
feed's Title, Headline, or Summary Color. 

6. (Optional) Set the local time zone for your site in the Time Zone 
drop-down list. 

7. (Optional) Change the Date Format (MM/DD or DD/MM) for the 
article's published date that shows in the article's header. 

8. Click OK. 

9. A  cursor is displayed. To insert the feed in a window of default 
size, simply click the mouse. 
OR 
More typically, to set the size of the feed window, drag out a region 
and release the mouse button. 

The feed window will be filled with a peach color with the URL shown—you'll 
need to publish the page to view the current new feed. Remember that the 
content will update automatically as the feed is updated on the original website. 
A typical published podcast feed could look as follows (but will update 
frequently): 

 

When the web visitor views the feed each episode can be played by clicking on 
the audio link, typically pointing to an MP3 file. Once downloaded and saved, 
the file can be played on a currently set default player (e.g., Windows Media 
Player). 
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Understanding e-commerce 
E-commerce entails the buying and selling of goods on the Internet. It's difficult 
to escape online retailing in any Internet session these days—you've more than 
likely used some form of Internet shopping at some point, when buying online 
CDs, books, holidays, etc. Any site that supports this kind of e-commerce 
activity will typically make use of a shopping cart system and a payment 
processing system. A shopping cart is a virtual basket (think of a supermarket 
basket) which stores your chosen items and is used in conjunction with a 
payment processing system (taking the place of the supermarket's checkout). 

For major companies, the shopping cart technology is developed in-house 
(maybe the payment processing is carried out by a third party company). For 
smaller companies or organizations, the shopping cart is normally a brought-in 
third-party solution due to the cost/resource limitations. There are many third-
party shopping cart providers that can be used—all account-based and equipped 
to accept credit cards instead of using a traditional payment gateway (e.g., by 
phone). 

So where does WebPlus fit into all this? Firstly, WebPlus allows you to choose 
one of several specially chosen shopping cart providers and, secondly, it allows 
you to connect to the shopping cart provider via a form or link on the WebPlus 
page. Forms allow for buying options (colors, quantity) to be set, as well as 
calculate tax rates, shipping, bulk items, etc. Links offer simple one-click 
purchasing without buying options. The features are provider-specific and as a 
result vary widely. 

Configuring your shopping cart provider 

A number of different shopping cart providers can be configured within 
WebPlus. These are the most commonly used and some, like PayPal®, you may 
have come across directly as an eBay® customer. The configuration process 
directs you to the provider's own site from where you can sign-up as a registered 
user. 

 Use the provider's website to find out more about unique shopping 
cart features. 
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To setup a shopping cart provider: 

1. Click the  Configure E-Commerce button on the Web Objects 
toolbar's E-Commerce flyout. 

2. From the E-Commerce Configuration dialog, you have two options 
depending on whether you are an existing or new user of one of the 
shopping cart providers, i.e.  

• If you're a new user, choose a shopping cart provider by enabling 
its radio button, then click the Sign Up Now button. The 
provider's web site is shown in a new browser window from 
where you can register with the shopping cart provider. 

• If you're an existing user, enable the button next to your chosen 
provider, and click Next>. This option simply sets the default 
provider for your site (rather than set up a provider account).  

3. The subsequent dialog is provider-specific and may show offline 
testing options, window selection, store IDs, currency options and/or 
tax choices. 

4. Click the Finish button to complete shopping cart configuration. 

As an example, choosing PayPal lets you define an email address to receive 
payments, or use a "Sandbox", a test tool, for trying out your shopping cart 
before going live (otherwise you may start making money before you're ready!). 
Click the Find Out More button to setup a separate Sandbox login in addition 
to your "live" PayPal login. 

Once you've configured the shopping cart, you'll need to Insert an e-commerce 
form. 
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Inserting an e-commerce object (PayPal) 
The creation of e-commerce objects within WebPlus takes a Wizard-based 
approach. An e-commerce object can be added to the web page as a form or link 
(i.e., a simple button or any object's hyperlink) by completion of a series of 
dialogs. Whether you choose to use forms or links depends on the characteristics 
of the items you are planning to sell, and how you want to sell your goods. 

For example, if you are a trader wishing to sell 
a quantity of bricks you could create an  
E-Commerce button (as a Buy Now link). 
This option would make an assumption about 
the potential transaction, i.e. that all the bricks 
are the same style/color and that the buyer would wish to purchase a fixed 
amount. 

This is because a link is only a button and cannot host any "interactive" buying 
options that would be need for more complex purchases. One buyer's click will 
buy a standard product offering—nothing more. Useful in some situations but in 
others completely inadequate. 

More complex purchases using E-Commerce Forms offer user interactivity 
coupled with flexibility. If we take the brick trader as an example again, a form 
can be used to host quantity and brick style/color options so that the customer 
has control and can get what he/she wants! 

 

Here the web visitor has chosen to buy 3600 bricks of style "Clamp - Orange." 

The dialog that is displayed when you add an e-commerce object will entirely 
depend on the currently enabled shopping cart provider (see Configuring your 
Shopping Cart provider on p. 261).  

 The following procedures assume that PayPal is configured as your 
shopping cart. 
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To insert an e-commerce object: 

1. Click the  Insert an E-Commerce object button on the Web 
Objects toolbar's E-Commerce flyout. 

2. In the Add PayPal Object dialog, pick the email address which is to 
receive the payment information. WebPlus will already assume that 
the email address set during shopping cart configuration is used. 
Alternatively, uncheck the Use the site default account box and set a 
different email address to override the site default. 

3. Pick an object type from the PayPal Form box. Select a "Form" radio 
button if you want to create an E-Commerce Form which will 
contain buying options (e.g., color or quantity). If the product for sale 
has no buying options then you can use a "Link" object (i.e., to create 
a clickable E-Commerce Button). 

4. (Optional). If a Form or Button is not what you are looking for, enable 
the last option instead to paste code in a subsequent dialog. This 
would be code generated from PayPal's website (look under Merchant 
Tools). Click Next>. 

5. In the next dialog, define a button for use. It's possible to enable a 
standard text button (when enabled, enter any text string), a standard 
image button (when enabled, pick from an attractive selection of 
presets in the scrollable window), or load an image button (when 
enabled, use the Browse... button to navigate and select your image). 
Images are embedded in your site by default; otherwise uncheck the 
last option. Click Next>. 

6. Item identification, pricing, tax, and weight information can be 
defined in the Item Details dialog. Options to be selected are: 

• Item Name: The item name for sale. Shown on the form and 
shopping cart. 

• Allow customer to specify the item name: Check to swap the 
above Item Name for a box in which the web visitor can enter 
their own item name (also good for specifying donation details). 

• Item ID: Add an easily identifiable string to track the item 
through PayPal. 
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• Currency: Set the currency in which the transaction will be 
made in. 

• Price: The price for the item. Shown on-screen by default. 

• Allow customer to specify the amount: Check to swap the 
above Price for a box in which the web visitor can enter their 
own price. Use with donation forms, where the customer sets the 
amount. 

• Override the tax settings..: Check to override provider's 
profile's tax setting for the item. If checked, specify a flat tax rate 
for the item, e.g. 0% for tax-free charitable donations. 

• Weight: Set an item weight if you're using weight-based shipping 
(US only), set in your PayPal profile. Typically, pounds (lb) are 
used as measurement, but kilograms (kg) can also be set if 
needed.  

Choose from the above settings and click Next>. 

7. For e-commerce forms only, two subsequent dialogs are shown: 

• The Item Description dialog lets you optionally include an image 
(e.g., to preview the item for sale), and short and long 
descriptions that will show in the form. Click Next>. 

• The Item Options dialog lets you create edit boxes, combo boxes, 
radio buttons, and fixed names (up to 10 options can be selected 
per form in PayPal; only one price-changing option) as 
appropriate—you can design from scratch or use previously 
saved options fields. Click Next>. 

8. In the Item Details dialog, set a default quantity in the input box, or 
check the box to let the user specify an amount at checkout.  
OR 
Set the Add Edit box option to let the customer define the quantity to 
be ordered. 
 
For shipping and handling associated with the order, enter a set 
amount for Handling, Shipping, and Extra Shipping charges. 
If left blank, the default PayPal's profile will be used instead. Click 
Next>.  
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9. In the Extra Customer Information dialog, choose to prompt the 
customer for an address, don't prompt, or require the customer to enter 
an address. Optionally, ask a question of the customer in the text box. 
Click Next>. 

10. The Payment Pages dialog offers some payment settings, i.e. 

• Enter the name of your Checkout Page Style (if setup in advance 
via your PayPal login). 

• Set a language for the PayPal login page. Pick for the drop-down 
list. 

• Change the text for the Continue button on the Successful 
Payment Page. 

• If needed, define Successful Payment Pages and/or Cancelled 
Payment Pages. Enter the page's URL or select an entry from the 
drop-down list. 

12. For e-commerce forms only, choose a form layout from the Form 
Layout dialog. Several check box options let you control what gets 
shown on the form layout, e.g you can disable the item's price. 

13. Click Finish. 

14.  To insert the form or button, position the cursor where you 
want it to appear on the page, then simply click the mouse. 

To edit an e-commerce form or button: 

1. Select the form, right-click the form and choose Edit E-Commerce 
Form.... 
OR 
Select the button, right-click the button and choose Edit E-Commerce 
Button.... 

2. Modify e-commerce settings screen-by-screen in the displayed dialog. 
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To convert to a standard form: 

• Right-click on the existing e-commerce form and choose Convert to 
Form. 

Using Smart objects 
For modern interactive web features (counters, forums, blogs, and more), 
WebPlus uses server-sided Smart objects placed on the page. Smart objects 
store gathered web visitor data on Serif's own secure server space. These objects 
are available from Serif Web Resources, a secure online service for not just 
creating and inserting smart objects, but for storing and managing object data 
once your site is published and live. 

Let's look at each Smart object you'll find in Web Resources and what you can 
do with them. 
 
Name Use 

Active 
Viewers 

Use to show how many people are currently viewing the web 
page. 

 
Blog 

A blog acts as a personal journal on your web page which hosts your 
own published articles in an easy-to-use RTF editor. Articles can be 
commented on by visitors to the web page. With blogs you can: 

• Add your own personal profile. 

• Add social bookmarking links. 

• Use article trackbacks for inter-blog cross-
referencing; use receive trackbacks. 

• Use tagging to categorize articles for easier user 
access. 

• Enable users to subscribe to articles (most recent 
articles/comments) via RSS feed readers. 
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 If you attempt to use Quick Publish without configuring your 
account settings first, the Quick Publish Configuration dialog will 
automatically open for you to do so. 

The Uploading Files dialog briefly appears before your page is displayed in 
your chosen browser. 

Using Serif web hosting 
Serif web hosting provides Serif-supplied web space for the user to publish to. 
By signing up to the hosting service you can simplify web publishing with the 
option of upgrading your web hosting capabilities over time.  

Some of the main advantages of Serif web hosting include: 

• Simple setup. Your web hosting account details are transferred to 
WebPlus in a single-click. Publishing is quick and easy. 

• Free hosting and email address for a limited period. 

• Hosting via Serif Web Resources. This means that you can access 
and change account details via the web (and not WebPlus), while 
managing your hosted Smart objects. 

Serif web hosting requires that you have a working Serif Web Resources login 
(see Using Smart objects on p. 267). If you're not already a registered user you 
must create a Web Resources account first. 

 Serif offers a range of additional web hosting packages for 
purchase, each offering increasing levels of service including higher 
transfer limits, more disk spaces, unrestricted domain naming, and 
email account support. Contact Serif for details. 

To activate web hosting (via WebPlus): 

1. Either  

• Click the  Smart Objects Tool on the Web Objects toolbar.  

• In the dialog, click My Hosting, select the browser in which you 
wish to view your page once it has been published. 
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OR 

• Click the  Publish site button on the Standard toolbar (or 
choose Publish Site from the File menu and select Publish to 
Web... from the submenu). 

• In the dialog, click WebPlus.net Hosting....  

2. From the Serif Web Resources dialog, choose various hosting option 
according to requirements: 

• Choose a password. 

• (Optional) Input your supplied Coupon code for your web 
hosting package (if purchased as an upgrade).  

• Select your Region (e.g., Europe, North America, etc.). This is 
the region in which your website will be hosted, so if you're 
targeting European users keep with the Europe option. 

3. Click Create Hosting. 

Your site can now be uploaded via Publish site>Publish to Web or Publish 
site>Quick Publish to Web on the Standard toolbar. 

 If you have an FTP account already set up as default in WebPlus, 
the new Serif web hosting account will become the new default. See 
Setting site properties (Publishing tab) on p. 54. 
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2D 

filter effects, 151 
3D 

filter effects, 154 
Instant 3D, 156 

absolute URLs, 223 
access control, 269, 276 

for Smart objects, 285 
signing up to, 281 
user groups in, 279, 280 

Active Viewers (Smart object), 
267 

adjunct colors, 212, 213 
adjustment (of pictures), 182 
albums 

in Media Bar 
creating, 176 

aligning 
objects, 130 

dynamic guides for, 132 
with grid or guides, 132 

paragraphs, 97 
Anchor Manager, 61, 226 
anchors, 223, 225 

hyperlinking to, 223 
animation effects, 193 
anti-spam (CAPTCHA), 249 
artistic text, 84 

on a path, 86 
Artistic Text Tool, 85, 87 
attaching 

objects to text, 133 
audio files, 197, 198 
automatic publishing, 295 

Back One command, 130 
background, 213 

sound, 198 
bevel effect, 151 
bitmap 

fills, 215 
transparency, 217 

Blog (Smart object), 267 
accessing, via offsite links, 36 

blur effect, 151 
borders, 159 

custom, 161 
Bring to Front command, 130 
browser preview, 289 
bulleted lists, 102 
cache 

clearing, 296 
Calendar Event Manager, 110 
Calendar Wizard, 111 
calendars, 110 

events for, 112 
inserting, 110 
public holidays for, 112 

CAPTCHA (anti-spam), 249 
characters 

styles, 100 
Choose Workspace, 18 
Clear Formatting, 97 
Clipboard 

copying and pasting to or from, 
119 

color 
gradient fill, 215 
schemes, 211 
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solid fill, 209 
tinting, 210 

color fill effect, 151 
Color Scheme Designer, 211 
Color Schemes 

assigning, 214 
modifying, 214 
presets, 212 

copying and pasting objects, 119 
counters, 268 
Creative Frame Tool, 79 
Crop to Shape, 126 
cropping objects, 125 
Curved Path Text Tool, 88 
defaults, 137 

saving global, 139 
updating, 138 

design template, 18 
digital cameras, 181 
dimensionality (Instant 3D), 156 
dot grid, 54 

snapping to, 132 
draw-type pictures 

importing, 169 
duplicating objects, 120 
dynamic guides, 132 
e-commerce, 261 

adding forms and buttons 
(PayPal), 263 

configuration, 262 
shopping cart 

hyperlinking to, 223 
E-Commerce Manager, 61 
effects 

2D filter, 151 

3D filter, 154 
bevel (Instant 3D), 156 
lathe (Instant 3D), 157 
outline, 153 
pictures, 182 
reflection, 152 
shadow, 153 

embedding vs. linking, 173 
emboss effect, 151 
events (calendar), 112 
export options (pictures), 177 

for individual graphics, 179 
favorites 

filter, 188 
feather effect, 151 
features 

key, 4 
File Manager, 61 
Fill Tool, 216 
fills 

bitmap, 215 
gradient, 215 
solid, 209 

filter effects, 151, 154 
filters (photo), 182 

applying, 184 
committing, 185 
favorite, 188 
masking with, 186 

Find and Replace, 92 
Fit Text to Curve, 87 
Flash movies, 194 
Font Manager, 61 
fonts, 97 

setting, 97 
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WebSafe, 98 
formatting text, 97 

Paste Format for, 121 
forms, 240 

controls 
editing, 248 

controls for, 245 
creating, 242 
structure, 240 
submission of, 248 

acknowledging, 249 
Forums (Smart object), 268 

accessing, via offsite links, 36 
Forward One command, 130 
frame text, 76 
frames (picture), 167 
frames (text), 76 

creating, 79 
Creative, 78 
HTML, 78 
margins/columns of, 80 
setting default properties, 137 
snapping to, 132 

Freehand Path Text Tool, 88 
FTP 

account details, 292 
migrating, 294 

settings, 292 
Gallery tab (Studio), 67 
glow effect, 151 
Google Maps, 69 
gradient 

color fills, 215 
transparency, 217 

groups, 136 

guides, 50 
dynamic, 132 
ruler, 51 
snapping to, 132 
sticky, 52 

hexadecimal color code, 210 
Hit Counter (Smart object), 268 
holidays (public), 112 
home page, 27 
hotlinking, 206 
hotspots, 226 

editing, 228 
HTML 

adding code to Web pages, 237 
IDs, 239 
tokens, 240 

HTML Frame Tool, 79 
Hyperlink Manager, 61, 225 
hyperlinks, 223 

setting color of, 213 
IDs 

HTML, 239 
Image Cutout Studio, 188 
Image Export Manager, 178 
importing 

pictures, 169 
text, 75 
TWAIN images, 181 

indents, 91 
inline pictures, 170 
installation, 12 
Instant 3D, 156 
Internet Service Provider (ISP), 

292 
Irregular Crop Tool, 125 
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iTunes, 252 
submission of podcasts to, 256 
subscribing to, 257 

JavaScript, 239 
navigation bars, 42 

joining outlines, 128 
key features, 4 
layout aids, 50 

dot grid, 54 
dynamic guides as, 132 
guides and rulers, 51 
snapping, 132 
sticky guides, 52 

letter spacing, 97 
lighting (3D), 156 
linear fills, 215 
linear transparency, 217 
lines, 143 

changing color or shading, 209 
drawing, 144 
editing, 146 
fitting text to, 86 
resizing, 122 
setting default properties, 137 
setting properties, 146 

linking vs. embedding, 173 
lists 

bulleted, 102 
numbered, 102 

locking object size or position, 130 
mailing lists, 269 
maps (Google), 69 
marquees, animated, 193 
masking (for picture 

adjustment/effects), 186 

master pages, 29 
adding, 37 
assigning, 39 
multiple, 39 
properties, 57 
rearranging, 38 
removing, 38 

Media Bar, 174 
metafiles, 169 
multiple selections, 118 
navigation, 29 

and site structure, 27 
bars 

hyperlinking to, 223 
excluding pages from, 47 

navigation bars, 27, 41 
adding, 42 
checking, 48 
creating, 42 
customizing, 44 
dynamic, 48 
editing, 44 
separators, 47 
styles, 46 

Navigation Manager, 48, 61 
News (Smart object), 268 
numbered lists, 102 
objects 

aligning, 130 
attaching code to, 237 
combining, 127 
copying, pasting, and 

replicating, 119 
cropping, 125 
defaults for, 137 
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joining, 128 
locking size or position, 130 
measuring, 54 
moving, 121 
ordering, 130 
resizing, 122 
rotating, 123 
selecting multiple, 118 
selecting one, 117 
snapping to dot grid or guides, 

132 
styles, 161 

saving, 163 
offsite links, 36 

adding, 36 
on-page color, 213 
opening an existing site, 22 
outline effect, 151, 153 
outlines 

joining, 128 
Page Locator, 33 
page margin, 50 
page security, 59 
pages 

adding and removing, 34 
attaching code to, 237 
background color, 213 
background sound, 198 
caching problems, 296 
cloning, 38 
default size/alignment for, 57 
hyperlinking to, 223 
on-page color, 213 
optimizing, for search engines, 

62 
parent and child, 28, 38 

properties, 57 
rearranging, 34 
security, 276 
selecting and viewing, 32 
setting size of, 57 
switching between page and 

master page, 34 
viewing, 31 

paint-type images, 169 
importing, 169 

Pan Tool, 32 
paragraphs 

alignment, 97 
formatting, 97 

parent/child pages, 28 
Paste Format, 121 
Paste Format Plus, 121 
Paste in Place, 120 
pasting objects, 119 
path text, 86 
PayPal 

adding forms and buttons to, 
263 

configuring, 261 
hyperlinking to shopping cart, 

223 
Pen Tool, 143 
Pencil Tool, 143 
Photo Gallery, 201 

creating, 203 
editing, 205 

PhotoLab, 182 
launching, 183 

picture frames, 167 
pictures 

adjustments for, 182 
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borders for, 159 
cropped 

adjusting, 172 
effects for, 182 
export options for, 177 
hyperlinking to, 223 
importing, 169 
inserting, 170 

via Media Bar, 177 
linking remote, 206 
Media Bar for, 174 
optimizing, 177 
popup, 231 
replacing, 171 
resampling, 181 

podcasts, 252 
adding episodes to, 255 
adding to page, 259 
creating, 254 
hyperlinking to, 223 
iTunes submission of, 256 
subscribing to, 257 

Pointer Tool, 117 
Poll (Smart object), 268 
popup rollovers, 231 
previewing 

customize browsers for, 289 
sites, 289 

profiles 
Smart object, 271 
workspace, 18 

proofing tools 
Site Manager, 60 

properties 
site, 54 

publishing 
to web, 291 

automatic, 295 
QuickPublish, 297 

QuickPublish, 297 
QuickShapes, 149 
radial 

gradient, 215 
transparency, 217 

raster images 
importing, 169 

reflection effect, 151, 152 
Registration Wizard, 3 
remote images, linking to, 206 
Replicate, 120 
resampling, 180 
Resource Manager, 61 
retouching (pictures), 186 
reverting to saved version, 22 
robots, 62 

using robots meta tag, 64 
using robots.txt, 65 

rollovers, 229 
popup, 231 

Rotate Tool, 123 
rotating objects, 123 
RSS Feed Manager, 255 
RSS Feed Tool, 254 
RSS feeds, 252 

adding articles to, 255 
adding to page, 259 
creating, 254 
hyperlinking to, 223 
subscribing to third-party, 257 

RSS Reader Tool, 258 
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ruler guides, 51 
rulers, 52 
saving a site, 23 
scanned images 

importing, 181 
schemes (color), 211 

modifying, 214 
search engine descriptors, 62 
search engines, 62 

robots meta tag for, 64 
robots.txt for, 65 
sitemaps for, 65 

selecting objects, 117 
Send to Back command, 130 
Serif 

web hosting, 298 
Web Resources, 267 

clearing Account details, 270 
creating account for, 270 
login, 270 

shadow effect, 151 
Shadow Tool, 153 
shapes 

closed, 150 
drawing and editing, 148 
fitting text to, 86 
gradient/bitmap fills for, 215 
resizing, 122 
setting default properties, 137 
solid fills to, 209 
transparency for, 217 

Shockwave Flash movies, 194 
shopping cart 

configuring, 261 
Shout Box (Smart object), 269 

signing in (access control), 284 
signing up (access control), 281 
Site Checker, 61 
Site Manager, 60 
site map (navigation), 42 
site structure 

and navigation, 27, 41 
offsite links, 36 

Site Structure tree, 27 
Site tab (Studio), 28, 29 
sites 

opening existing, 22 
previewing, 289 
properties of, 54 
saving, 23 
starting from scratch, 21 
structure, 27 
working with multiple, 23 

size 
of objects, 122 

Smart Object Tool, 270, 277 
Smart objects, 267 

access control for, 285 
creating, 271 
deleting, 275 
editing, 273 
exporting, 274 
hyperlinking to, 223 
managing, 274 
profiles for, 271 
security for, 277 

snapping, 132 
solid colors, 209 
sound, 197 

adding, 197, 198 



310  Index 

 

hyperlinking to, 223 
Square Crop Tool, 125 
Startup Wizard, 17 
sticky guides, 52 
story text 

flowing in frame sequence, 83 
Straight Line Tool, 143 
Straight Path Text Tool, 88 
styles 

font, 97 
HTML-compliant, 67 
object, 161 

saving, 163 
text, 99 

Styles tab, 152 
submission (of forms), 248 
system requirements, 12 
tables, 107 

Creative, 107 
HTML, 107 

template (design) 
adding pages from, 35 
creating site with, 18 

text 
adding to text frame, 76 
artistic, 84 
attaching objects to, 133 
bullets and numbering, 102 
changing color or shading, 209 
creative text frames, 76 
editing, 88 
formatting, 97 
frame, 76 
HTML text frames, 76 
importing from file, 75 

named styles, 100 
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